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 أنواع البيانات :الأولالفصل 

 

القيم في التطبيقات البرمجية بكتابتها مباشرة وهو ما  أويتم التعامل مع البيانات 

باسم وهي المتغيرات  إليها بالإشارة أو  Literalنسميه الثوابت الصريحة 

Variables  

 ومن أنواع البيانات: 

  Stringsالسلاسل الرمزية  -1

Strings: which store a series of characters 

 : إلىوتقسم  

  الحروف الأبجدية 

 الرموز الخاصة 

  الأرقام 

 55,6,12-,114+90مثل   Integersالأعداد الصحيحة  -2

Integers: which represent complete integer values  

 وتكتب بشكلين: Real Numbersالأعداد الحقيقة  -3

  باستخدام الفاصلة العشرية 

  الصيغة العلمية 

 Exponential Notation 

 (  True and Falseقيمتين ) تأخذوهي   Booleanالثوابت المنطقية  -4

تنفيذ البرنامج أما  إثناء( عبارة عن قيمة ثابتة لا تتغير Constantالثابت )

 تنفيذ البرنامج  إثناءالمتغير فهو قيمة قد تتبدل )تتغير( 

  Assignment Statementsجمل التعيين 



 

 

Variable_Name هو اسم المتغير 

المساواة وتعني نقل المعلومات  إشارة =
(Information Move )العنوان  إلى

 لذاكرة المحدد في ا

Expression  إنمن الجملة ويمكن  الأيمنالطرف 
متغيرا آخر معرفا في  أويكون ثابتا 

تعبيرا  أوسلسلة حروف  أوجملة سابقة 
منطقيا حسب نوع المتغير  أورياضيا 

 من الجملة  الأيسرفي الطرف 

 

 العمليات الحسابية

Arithmetic , Logical and Relational 

 رمز العمية 
Operation Code 

 العملية
Operation 

 Additionالجمع  +
  الطرح =

Subtraction 
 Multiplicationالضرب  *
 Divisionالقسمة  /

Mod  المعامل المطلقModulus 
 Exponentiationالمعامل الأسي  ^
 

 ANDالنتائج المنطقية عند استخدام 

A and B  B A 

True True True 
Fals 

E 
Fals 

e 
True 

Fals 
E 

True  
E 

Fals 
E 

Fals 
E 

Fals 
E 

Fals 
e 

 



 

 

 ORالنتائج المنطقية عند استخدام 

A Or B B A 

True True True 
True False True 

True True False 
False False False 

 

  NOT النتائج المنطقية عند استخدام

Not A A 
False True 

True False 
 

 العلائقية المستخدمة:مجموعة العمليات 

 Operationالعملية  Symbolالرمز 
 Greater thanاكبر من  >
 Less thanاقل من  <

 تساوي أواكبر من  =>
Greater than or equal 

 تساوي  أواقل من  =<

Less than or equal 
 Equalالمساواة  =

 Not Equalلا تساوي  ><
 

 التالية : الأولوياتاليمين حسب  إلىيتم تنفيذ العمليات من اليسار 

 الأولوية 
Priority 

العملية 
Operation 

  Symbolالرمز 

 الأقواس 1
Parenthese

s 

)(  

رفع القوى  2

Exponentia
^  



 

 

tion 

الضرب  3
 والقسمة 

Multiplicati
on and 

Division  

 

/،*  

المعامل  4
 المطلق 

Moduluse 

Mod  

 الجمع  5

Addition 
 

 الطرح
Subtractio

n 

،+- Arithmetic 

 المقارنة 6

Compariso
n 
 

<,>,<=,>=,=,>< Relational 

 المنطقية  7
Logical 

NOT 
AND 

OR 

Logical 

 

Example:  

A=2*3+6*3-(4+2)*2 

A=2*3+6*3-6*2 

A=6+6*3-6*2 

A=6+18-6*2 

A=6+18-12 

A=24-12 



 

 

A=12 

 Problem Solvingحل المسائل 

  المدخلاتInput   

  المعالجةProcess 

 الإخراج Output 

 : الآتيةولحل مسألة معينة نتبع الخطوات 

To solve a problem, do the following: 

 فهم وتحليل المسألة -1

Analyze the problem 

  فهم المسألة 

Problem understanding 

  تحديد المدخلات 

Knowing what the inputs to the problem are 

  تحديد المخرجات 

Determining the desired outputs 

 الخطوات المطلوبة للحصول على المخرجات المرغوبة  إتباع 

Knowing what the necessary processing steps to 

the solution are 

 Design a solutionتصميم الحل  -2

  Coding the programكتابة البرنامج  -3

 Test the programفحص وتدقيق البرنامج   -4

 Validate the solutionالحل  تقسيم -5

 

 



 

 

 Pseudo Codesأشباه البرامج 

A Pseudo Code is a set of English-Like statements used to help 

in solving problems 

Example: Write a pseudo code to calculate and print a student's 

semester grade average for five scores.  

1- Get scores for 5 courses 

2-Add (sum) the scores together 

3-Divide the sum by 5 

4-Print the results (Average)  

 Flowchartsمخططات سير العمليات 

The rectangular process box 
indicates the action to be 

taken  

 

The parallelogram symbol 
represents the input or output 

 

The diamond shaped decision 
box asks a question that 

requires a decision, such as 
yes or no or true or false 

 

A flowchart begins and ends 
with the oval stop or start 

symbol 

 

The circle is called a connector 
symbol because it connects 
the paths in a flowchart the 

connector is also used when a 
flowchart is larger than one 

page  

 

Flow lines or arrows connect  



 

 

the above symbols to indicate 
the sequence of operations 

 

 Flowchart Constructsتراكيب المخططات 

  Sequenceالتركيبة المتتالية 

A Sequence, as the name indicates , means to perform one step 

at a time, and follow it by the next step and so on and so on 

and so forth .  

Example : Draw the flowchart to solve the following equation:  

X=A*B-C    5 

 

 

   

 

 

  Selectionالتركيبة الاختيارية 

A Selection means to perform an action only if a condition is 

true  

Syntax: If Condition then Statement(A) 

Else Statement(B) 

End if 

 Iteration or Loopingالتركيبة التكرارية )الدورانية( 

Iteration or Looping means to perform an action as long as a 

condition is true. 

Start 

A,B,C 

X=A*B-C   5 

X 

Stop 



 

 

 

  Information Systemsأنظمة المعلومات :الفصل الثاني

 

An Information system consists of six main parts: 

1-Hardware are solid equipment that including the computers 

and all the support equipment , such as input and output 

devices , storage devices and telecommunication equipment. 

2-Software: The term software refers to computer programs 

that control the hardware parts of the system to achieve 

system objectives 

3-Data are facts that are used by programs to produce useful 

information and to achieve system objectives 

4-Procedures are the policies that govern the operation of an  

information system  

5-The term people refers to the persons dealing with the  

information system  

6-Computer Networks are communication system that connect 

two or more computers so that they can exchange information 

and share resources 

 هناك ستة عناصر رئيسية يتكون منها نظام المعلومات وهي:

 Hardwareالمعدات  -1

 Software   جيات البرم -2

 Dataالبيانات  -3

 Procedures الإجراءات -4

 peopleالناس  -5

 Networksالشبكات  -6



 

 

Functions of Information Systems : 

1-Accounting, which records all financial activities. 

2-Marketing, which handles planning pricing, promoting 

3-Human Resources (HR) which is responsible for finding, hiring 

people 

4-Production which creates finished goods 

5-Research which identifies, investigates, and develops new 

products 

Management Levels: Information systems provide information 

essential to running an organization in each management level 

in most organization there are three management level  

 : Functions of Information Systems  وظائف أنظمة المعلومات 

 المحاسبة  -1

 التسويق -2

 وارد البشرية الم -3

 الإنتاج -4

 البحث -5

 management level الإدارةمستويات 

  الدنيا  الإدارةمستوى 

Low level: they monitor day-to-day events and make 

decisions when necessary 

  الوسطى الإدارةمستوى Middle level  

Middle level: Managers in this level deal with 

controlling planning and decision-making they 

implement the long-term goals of the organization 



 

 

  العليا الإدارةمستوى Top level  

Top level: managers are concerned with long-

range planning they need information to help 

them in the planning of the future growth and 

the direction of the organization  

Computer-based Information systems:  

Transaction Processing , Management 

information , Decision support and Executive 

support systems  

   Transaction Processing Systems( TPSأنظمة معالجة البيانات ) 

 MIS) )Management Information Systems الإداريةأنظمة المعلومات 

can be defined as a set of formal business systems designed to 

provide information for an organization it produces 

standardized reports used to support middle managers three 

common types of reports are produced by an MIS , which are: 

*Periodic reports, which are produced at regular intervals  

*Exception reports which report unusual events 

*Demand reports which are produced upon request 

 

Decision Support Systems  ( أنظمة دعم القرارDSS): 

supports managers in no routine decision-making tasks 

it consists of four parts, which are: 

   The User*متخذ القرار 

    System software*برمجيات النظم

 The Data (Internal and External)* البيانات الداخلية والخارجية 

  Models* نماذج القرار



 

 

  Independent Variables تسمى البيانات المدخلة بالمتغيرات المستقلة

 Dependent Variables  المخرجات تسمى بالمتغيرات غير المستقلة إما

 

 : من نماذج القرار هي أنواعثة لاهناك ث

 

 Strategic Models : assist top-level managers* إستراتيجيةلاالنماذج ا

in long-range planning 

 Tactical Models: assist mid-level managers* النماذج التكتيكية 

 Operational Models: help low-level managers* نماذج العمليات 

Executive Information Systems (EIS) present highly summarized 

information in a flexible graphical format which is designed for 

top-level executive managers these systems provide direct 

access to a company's performance indicators  

 (EIS) المعلومات التنفيذية أنظمة

Multiple choice 

1-Data are facts that are used by programs to produce useful ?? 

...C.. 

A) marketing   B)networks     C) information    D) hardware  

2-which of the basic organizational functions records all 

financial activities such as billing customers and paying 

employees ??....B.. 

A) Marketing    B)Accounting   C) production    D) research  

3-which of the basic organizational functions is responsible for 

finding and hiring people?? ..c... 

A) Marketing    B) accounting   C) Human Resources      D) 

Research  

4-which of the following computer-based information system 

produces standardized reports used to support middle 



 

 

managers?..d... 

A)BIS    B)CIS    C) EIS    D)MIS 

5-which of the following computer-based information system 

produces graphical reports for top-level executive managers? 

...a... 

A) EIS    B)CIS    C)DSS    D) MIS 

6-The inputs to a model are called?? ....b... 

a)spreadsheets      b) independent variables       c) dependent 

variables       d) equations  

7-the outputs of a model are called .?...c) dependent variables 

8-a strategic mode assists long-range planning ? d) top-level 

managers  

9-a mathematical representation of a real-world situation is 

called ? b) a model  

10-a computer system that supports managers in non-routine 

decision-making tasks is called?   a) DSS 

11-MIS stands for ?b) management information systems  

12-DSS stands for ?. c) Decision Support Systems  

13-EIS stands for ? b) executive Information Systems 

14-DSS is used by ? c) middle-level managers only  

15-a TPS helps an organization keep track of??? C) routine 

operations? 

 

 

 

 

 

 



 

 

 

 Microsoft Excel إلكترونيةلاالجداول ا :الفصل الثالث

 

   excel ساسية لنافذةلاالعناصر ا

 Title bar-1 شريط العنوان 

2-Quick access toolbar : allows quick access for the common 

functions that are frequently     شريط أدوات الوصول السريع  used 

  the office button-3    زر اوفيس  

4- The formula bar becomes active when you type or change 

information in a worksheet  

  الرياضية الصيغة شريط

 -active cell 5 النشطة  الخلية

 -Worksheets 6 العمل أوراق

 -scroll bar 7  التصفح شريط

 -status bar 8  الحالة شريط

  Ribbon -9 الشريط

 Tabs- 10التبويبات  

 

 : من تتكون worksheet ورقة العمل

 Rows صفوف

 Columns أعمدة

 Cell  خلية



 

 

  Selecting الخلايا تحديد

click the cell or press the arrow keys to move to the cell  1- 

to cancel a selection of cells click any cell on the worksheet 2- 

to select all cells on a worksheet click the select all button 3- 

  4-to select a range of cells select the cell by clicking in it hold 

down the mouse button drag down and across to the column 

you want to select 

to select an entire row click the row heading 5- 

  6- to select nonadjacent rows select the first row and then 

hold down Ctrl and select the other rows  

 

  Adjusting row height الصفوف ارتفاع تعديل

Select a  cell on the row whose height you wish to change on 

the home tab in the cells group click format click row height 

type the desired row height in the row height dialog box  

  Auto fill التلقائية التعبئة

select the cells that contain the data that you want to fill into 

adjacent cells 1- 

 2- drag the fill handle ( the small black square in the bottom 

right-hand corner of the selected cell) your pointer turns into a 

large plus sign  

drag to the new range of cells you want 3- 

release the mouse button 4- 

 



 

 

 Adding borders to cells  الخلايا  إلى حدود إضافة

1-select the range you want click on the home tab in the font 

group click the arrow next to borders  

- select a border style 2- 

3- to change the color of the borders click the arrow next to 

borders then click line color and select the color you want  

to change the border style click the arrow next to borders then  

4- click on line style and select the style you want 

 

  Text Orientation النص تدوير

select an adjacent cell that you want to format 1- 

2-click on the home tab in the alignment group click orientation 

choose the orientation direction that you prefer  

  styles نماطلاا

1-select the cells that you want to format click on the home tab 

in the styles group click cell styles  

click the cell style that you want to apply 2- 

3- to remove the cell style from the selected cells click on the 

home tab in the styles group click cell styles and then click 

normal  

 

  Format as table كجدول البيانات تنسيق

1-select the cells that you want to format click on the home tab 

in the styles group click format as table  



 

 

click the table format that you want to apply 2- 

3-the format as table dialog box will appear select my table has 

headers if the table has header row and then click ok  

each heading cell displays a dropdown arrow so that you can 

filter or sort the table 4- 

5-to convert a table to a normal range click on the design tab in 

the tools group click convert to range  

  Conditional formattingالشرطي التنسيق

select the cells you want to apply conditional formatting 1- 

click on the home tab in the styles group click conditional 

formatting 2- 

3-click highlight cells rules and then select the criteria you want 

to use for example click on between  

4-a dialog box will appear enter the values you want to 

reference in the text box  

5-select the required formatting click the custom format option 

if you want to create your own formatting selections  

6-click ok  

7-to remove conditional formats select a cell that has the 

conditional formats you want to remove click on the home tab 

in the styles group click clear rules  

 

  Formatting Numbers رقاملاا تنسيق

1-select the cells to which you want to apply a format click on 

the home tab in the number group click the dialog box launcher  



 

 

the format cells select the number tab 2- 

in the category box click number 3- 

4-choose the number of decimal places  

5-ok 

  Currency symbol العملة رمز

1-select the cells to which you want to apply a format click on 

the home tab in the number group click on the down arrow 

next to the currency icon  

select the symbol that you want 2- 

 

To display more currency symbols do the following : 

click on the home tab in the number group click the dialog box 

launcher * 

click in the symbol box to display a menu of available currency 

symbols select the symbol that you want 

 

  Percentages المئوية النسب

1-click on the home tab in the number group click percentage if 

the cell contains numbers percentage formats multiply the cell 

value by  100 and displays the result with a percent symbol  

2-if the numbers are typed into the cells after you have apply 

the percentage formatting the cell value will appear with a 

percent symbol  

 



 

 

  Formatting Datesالتواريخ تنسيق

1-Right click the cell or range of cells you want to format 

choose format cells from the shortcut menu in the category box 

select date this category contains various formats for 

presenting dates  

select the required date format 2- 

ok 3- 

  Applying or Removing comma إخفائه أو فلآلاا فاصل إظهار

select the cells to which you want to apply a format 1- 

click on the home tab in the number group click comma style 2- 

3-To remove comma style formatting click on the number 

format icon and then select General or number  

  Freezing Row and column Titles فقيةلأوا الرأسية العناوين تثبيت

Click the cell below and to the right of which you want to split 

to appear 1- 

2-click on the View tab in the Window group click Freeze panes 

and then select Freeze panes you will notice a line below the 

column's titles and a line to the right of the rows titles  

3-if we now scroll to the right and also down the sheet the 

row's and column's titles will remain visible  

4-to unfreeze rows and columns titles on the window group 

click freeze panes and then select unfreeze panes  

to freeze columns titles click on the View tab in the window 

group click freeze top row 5- 



 

 

to freeze rows titles click on the View tab in the window group 

click freeze first column 6- 

  Sorting Data البيانات فرز

Sorting is used to sort (order)  the data in ascending or 

descending order  

select any cell within the list range 1- 

click on the home tab in the sort & filter group click one of the 

following 2- 

Click to sort in an ascending order* 

Click to sort in an descending order * 

 

In case we need to sort the data according to SALRY and then 

to SURNAME do the following : 

select any cell containing data 1- 

click on the home tab in the sort & filter group 2- 

Enter SALARY in the sort by box 3- 

under sort on select the type of sort you want 4- 

under order select how you want to sort 5- 

to add another column to sort by click add level 6- 

enter SURNAME in the then by field 7- 

8-if your list contains a header row clear the my data has 

headers check box then the header will be sorted and get 

mixed up along with the rest of the information contained 

within the list  



 

 

9-ok  

  Filtering التصفية

Data filtering is used to locate information quickly hiding 

records not interested in  

  Auto Filtering التلقائية التصفية

Auto Filtering is a quick and simple way to filter through that 

information that are similar characteristics  

click on the home tab in the sort & filter group click filter 1- 

Arrows will appear to the upper right of the column labels in 

the list  

2- the lists contain all the unique values for the column plus the 

choices 

 

 Removing AutoFilter التصفية إلغاء

 ( راتبين اعلي) للرواتب قيمتين اعلي ظهارلإ

to remove the drop-down filter lists and redisplay all of your 

records click on the home tab in the sort & filter group click 

filter this removes the check marks and redisplays the original 

records  

1-click on the home tab in the sort & filter group click filter 

Drop down arrows will appear to the upper right of the column 

labels in the list  

select the arrow next to the salary field and then select number 

filters select top 10 2- 



 

 

3-the top 10 AutoFilter dialog box select top to display the rows 

with high values in the salary column  

select the number of items of the whole list that you want to 

display 4- 

5-ok 

 2000 عام قبل العمل بدءوا الذين الموظفين سجلات ظهارلإ

1-click on the home tab in the sort & filter group click filter 

Drop down arrows will appear to the upper right of the column 

labels in the list  

2-click the arrow in the column that contains the (Date) click 

(Date Filters) and then select custom filter  

the custom AutoFilter dialog 3- 

click the option before 4- 

choose the date (or enter 1/1/2000 )5- 

ok 6- 

 Advanced filter المتقدمة التصفية

The Advanced Filter command can filter a list in place like the 

AutoFilter command but it does not display drop-down lists for 

the columns Instead you type the criteria (conditions you 

specify to limit which records are included in the result set of a 

filter) you want to filter by in a separate criteria range above 

the list  

 : يلي ما اتبع القائمة سجلات لتصفية

click on any cell in the list 1- 



 

 

click on the home tab in the sort & filter group click Advanced 

2- 

the advanced filter dialog box will appear 3- 

the list range box display the range of the data you want to 

filter 4- 

click in the criteria range box and select the range A2:C3 from 

the worksheet 5- 

ok 6- 

  Searching and Replacing data البيانات واستبدال بحث

click on the home tab in the editing group click find and select 

1- 

click find the find and Replace dialog box will appear 2- 

in the find what box enter the text or numbers you want to 

search for 3- 

click find next 4- 

 

To replace a text or number do the following  

1-press Ctrl+F to display the Find and Replace dialog box click 

on Replace tab in the Find and Replace dialog box in the 

Replace with box enter the replacement characters and specific 

formats if necessary  

2-To replace the highlighted occurrence click replace or click 

replace all to replace all occurrences of the found characters 

 



 

 

  Worksheet Margins العمل ورقة هوامش

The Margins of your workbook are the areas of space between 

the edge of the paper and the edge of the text there are four 

margins on every page : top bottom left and right you can set 

each one individually  

1-click on the page layout tab in the page setup group click 

Margins click custom Margins the page setup dialog box will 

appear  

2-in the boxes for top bottom left and right margins use the 

arrows to enter the measurement you want for each margin  

3-to center a worksheet data horizontally on the page between 

the left and right margins select the horizontally check box 

under center on page  

ok 4- 

  Worksheet Orientation العمل ورقة اتجاه

1-click on the page layout tab in the page setup group click 

Orientation and then click portrait or landscape  

  Worksheet header and footer العمل ورقة وتذييل رأس

A Header is information that will appear at the top of every 

page printout footer is information that appear at the bottom 

of every page to add text in header footers in a worksheet do 

the following  

click on the insert tab in the text group click header & footer 1- 

2-the header & footer tools and design tabs will appear the 

worksheet will appear in the page layout view  



 

 

3-to add a header click the left center or right header or footer 

text box at the top of the worksheet page  

4-to add a footer click the left center or right header or footer 

text box at the bottom of the worksheet page type the footer 

text  

5-to customize your header and/or footers under header & 

footer tools click on the design tab in the header & footer 

elements click to insert date click to insert time click to insert 

page numbering and click to insert worksheet name into 

headers or footers  

  Scaling Worksheet to fit a page  الصفحة لملائمة العمل ورقة تحجيم

1-click on the page layout tab in the scale to fit group click on 

the drop down arrow next to width box and select one page  

2-click on the drop down arrow next to height box and then 

select one page excel will shrink the data to fit in one page  

  Displaying Gridlines When Printing الطباعة عند الشبكة خطوات إظهار

 المصنف تنقسم التي والعرضية الطولية الخطوط هي Gridlines الشبكة خطوط

  خلايا إلى

Gridlines are the lines on an excel worksheet that assist the 

user in lining up the cell pointer with a particular column letter 

or row number  

 

To print a worksheet without cell Gridlines on the printout only 

(and keep Gridlines on the screen) click on the page layout tab 

in the sheet Options group clear the print check box under 

Gridlines  



 

 

To print a worksheet with cell Gridlines select the Gridlines 

check box 

 Printing the Excel Row and Column  عمدةلاوا الصفوف رؤوس طباعة

Headings 

Row headings are row numbers located to the left of the 

worksheet Column headings are letters or numbers that appear 

at the top of the columns  

1-to prevent row headings and column headings to appear on a 

printed worksheet click on the page layout tab in the sheet 

Options group clear the print check box under headings  

to print row headings and column headings select the print 

check box 2- 

 

  Printing Rows or Column Titles العناوين طباعة

click on the page layout tab in the page setup group click print 

titles 1- 

2-the page setup dialog box will appear click on the sheet tab 

under print titles do any of the following  

*in the Rows to repeat at top box enter the reference of the 

rows that contain the column labels or click and then select the 

title rows that you want to repeat in the worksheet after you 

finish selecting the title rows or columns click the again to 

return to the dialog box  

*in the  columns to repeat at left box enter the reference of 

columns that contain the row labels  

 



 

 

 Paste Special خاصة نتائج على للحصول ولصقها الخلايا نسخ

Excel provides a more advanced pasting feature called paste 

special which provides you with a number of pasting options 

paste special only works with the copy command use paste 

special command to specify  other options such as  : 

**copy the cells that contain  the data that you want click on 

the home tab in the clipboard group click the drop-down arrow 

that appears at the bottom of the paste button the paste 

special dialog box will appear in the paste special dialog box do 

one of the following  

***all: pastes all cell contents and formatting of the copied 

data  

formulas  (الصيغ حدد :)***is very helpful when you want to 

paste all the text numbers  and formulas in the current cell 

selection without their formatting  

Operation (العميلة خيار )***allows you to perform arithmetic 

between each pasted cell and the cell it overwrites 

   values ***القيم  حدد

Values calculate the results of the formula and paste only the 

resulting value useful when you no loger need the underlying 

calculations  

 

 *** Transpose  الموضع تبديل

allow you to change the orientation of the pasted entries 

 



 

 

  creating formulas الرياضية الصيغ إنشاء

a formula is a mathematical calculation that may contain 

numbers cell references and mathematical operators Excel has 

several major operators 

Create the table 1-  

2-click the first cell that you  want to use in the formula  

type in one of the mathematical operators type 3-  

click the second cell you want to use in the formula 4-  

press enter 5- 

  Error Values الصيغ باستعمال المقترنة الخطأ قيم

NAME   the text has been entered in a formula which is not 

allowed #  

N/A   the value is not available # 

the column is not wide enough to display the number    ##### 

#VALUE   the text has been entered when the formula expects a 

nurse  

#DIV/0   the formula is trying to divide by zero which is not 

possible 

  Functions الدوال

A Functions is an operation whose use simplifies the formula 

building when you enter a function name with a pair of 

parentheses and must use arguments  

select the cell where you want the formula to appear 1- 



 

 

2-click on the formulas tab in the function library group click 

insert function the insert function dialog box will appear  

 Function تلاالدا مكتبة مجموعة ومن Formulas صيغ تبويب علامة إلى انتقل

library دالة إدراج انقر  

3-within the search for a function type a description about the 

function you require and then click ok  

A list of possible correct functions will appear in the select 

function ((الدالة تحديد  ))4-section of the dialog box select the 

required function and then ok  

 5- the function arguments  dialog box will appear highlight the 

range of numbers you want to average by clicking and dragging 

across the appropriate cell 

 ((The function argumentsوسائط الدالة  ))  

  Relative and absolute cell references والمطلقة النسبية الخلايا مراجع

Absolute Reference leaving the column references that 

combine relative and absolute references are called Mixed 

References  

( C$3)فمثلا  فقط العمود على الدال الحرف قبل رلاالدو مةلاع اكتب عامود لتثبيت

  دائما الثالث الصف في الموجودة القيمة المعادلة تستخدم أن يجب تعني

 لموقع تبعا متغيرا يكون فانه الصف إما C العمود تستخدم إن يجب تعني C3$ إما 

  المعادلة نسخ

  Sum Functions الجمع دالة

Select the cell in which you want the total 1- 

2- Click on the home tab in the Editing group click AutoSum A 

Sum formula is entered automatically  



 

 

3- Press the Enter key on your keyboard the total will appear in 

the selected cell 

4- if the range is not correct drag the mouse through different 

cells to select them press the Enter key  

  Average Function الحسابي الوسط دالة

  عددها على مقسوما المشاهدات مجموع يعني الحسابي الوسط

The AVERAGE function can be used to find the average number 

of the selected cells to calculate an average  

1- Select the cell in which you want the average to appear 

2- Click on the home tab in  the Editing group click the drop 

down arrow next to AutoSum click Average  

3- A dotted line will appear around the selected cells  

 Fill the result into adjacent cells -4 المجاورة  الخلايا إلى الناتج بتعبئة قم

 

  Maximum and minimum value الدنيا والقيمة القصوى القيمة حساب

1- Select the cell in which you want the result to appear  

2- Click on the home tab in the Editing group click the drop 

down arrow next to AutoSum click max  

3- A dotted line will appear around the selected cells  

4- press the Enter key  

5- use the minimum function to show the lowest number 

within a selected range  

 



 

 

  The date function التاريخ دالة

1- Select the cell where the results will be displayed  

2- Click on the formulas tab in the function library group click 

date & time  

3-click on today  

To format a date do the following  

1- Right click the cell or range of cells you want to format 

choose Format Cells from the shortcut menu in the Category 

box select date this category contains various formats for 

presenting dates  

2- Select the required date format  

3- click ok 

Day دالة 

1- Add the today function into the appropriate cell 

2- Click on the cell where you want the result to be displayed  

3- Click on the formulas tab In the function library group click 

date and time click on day in the list  

4- the function argument dialog box will appear click on the cell 

that contains the date function the selected cell reference will 

appear in the dialog box  

5- click ok 

Month دالة  

The MONTH function returns the month value for a date  

1- Add the TODAY  function into the appropriate cell  



 

 

2-Click on the cell where you want the result to be displayed  

3-Click on the formulas tab in the function library group click 

date and time click on MONTH in the list the function Argument 

dialog box will appear  

4- Click on the cell that contains the date function the selected 

cell reference will appear in the dialog box  

 year دالة

1-Add the today function into the appropriate cell  

2-Click on the cell where you want the result to be displayed  

3-Click on the formulas tab in the function library group click 

date and time click on year in the list  

4-Click on the cell that contains the date function the selected 

cell reference will appear in the dialog box click ok 

Text Functions النصية الدوال  

Excel provides text functions designed to compare and 

manipulate the characters stored within cells  

PROPER النصية الدالة  

Proper: capitalizes the first letter in a text string and any other 

letters in the text that follow any character other than a letter  

1-Click on the cell where you want the result to be displayed  

2-Click on the formulas tab in the function library group click 

text click on PROPER in the list  

3- Enter the cell reference in the dialog box and then click ok  

UPPER النصية الدالة  



 

 

Upper function converts the whole text to uppercase letters 

1- Click on the cell where you want the result to be displayed  

2-Click on the formulas tab in the function library group click 

text  

3- Enter the cell reference in the dialog box and then click ok 

LOWER النصية الدالة  

LOWER function converts all uppercase letters in a text string to 

the lowercase  

1- Click on the cell where you want the result to be displayed  

2-Click on the formulas tab in the function library group click 

text click on LOWER in the list  

3-Enter the cell reference in the dialog box and then click ok 

Left النصية الدالة  

Use left function to remove unwanted characters appears on 

the right side of your data  

1-Click on the cell where you want the result to be displayed  

2-Click on the formulas tab in the function library group click 

text click on LEFT in the list  

Text: is the text that contains the characters you want to 

extract  

Num_chars : specifies the number of characters you want to 

extract 

  3-Click ok  

 



 

 

Right النصية الدالة 

1-Click on the cell where you want to the result to be displayed  

2-Click on the Formulas tab. in the Function Library group click 

text  

3-Specify the arguments of the equation and then click ok 

MID النصية الدالة  

Use MID function to remove unwanted characters on both 

sides of the data 

1-Click on the cell where you want the result to be displayed  

2-Click on the Formulas tab. In the Function Library group click 

Text click on MID in the list. The function Argument dialog box 

will appear  

3-Click ok 

TRIM النصية الدالة  

use the TRIM function to remove all additional spaces from text 

except for single spaces between words  

1-Click on the cell where you want the result to be displayed  

2-Click on the Formulas tab. in the function library group click 

text click on TRIM in the list. The Function Argument dialog box 

will appear  

3-Click on the cell that contains the additional spaces you want 

to remove and then click ok  

 

 



 

 

Math & Trig Functions والمثلثات الرياضيات دوال  

Excel provides built-in function for performing mathematical 

calculations  

SUMIF الشرطي الجمع دالة  

The SUMIF sums the values within a range that meet specified 

criteria, We want to see the total value of all sales for Amman 

area  click on the cell where you want the result to be displayed  

1-click on the formulas tab. in the function library group click 

Math and Trig click on the SUMIF in the list 

2-Within the dialog box specify the following:  

*Range: the range of cells to evaluate*  

**Criteria: the range that defines which cells will be addes  

*Sum_range: the actual cells to sum*  

Round الدالة  

Round function: rounds a number to a specified number of 

digits  

1-Select the cell where you want to place the result of 

calculation. Click on the home tab in the Editing group click the 

drop down arrow next to AutoSum Click more functions  

2-The Insert Function dialog box will appear select Round and 

then ok. The function Argument dialog box will appear  

3-In the number section of the dialog box specify the number 

which you want to round  



 

 

4-In the Num_digits section of the dialog box specify the 

number of digits which you want to round  

Round Up & Round Down دالة  

  الصفر عن بعيدا كبرلاا الصحيح العدد إلى رقم لتقريب Round Up دالة تستخدم

Round Up: rounds a number up away from zero while Round 

Down function rounds a number down toward zero  

1-Click on the cell where you want the result to be displayed 

click on the Formulas tab in the function library group click 

Math and Trig click on ROUND DOWN in the list the function 

Argument dialog box will appear  

2-The Insert Function dialog box will appear select Round and 

then ok the function Argument dialog box will appear  

3-In the number section of the dialog box specify the number 

that you want to be rounded down  

4- In the Num_digits section of the dialog box specify the 

number of digits to which you want to round a number  

 

COUNT الإحصائية الدالة  

 تشتمل لا التي الخلايا وتتجاهل معين نطاق في الرقمية الخلايا عدد لحساب تستخدم

  بيانات على أو أرقام على

The COUNT function counts the number of values In a list cells 

containing blanks text or error values are ignored  

1- Click on the Formulas tab in the function library group click 

on Statistical and then select COUNT the function Argument 

dialog box will appear  



 

 

2-Select the range of numbers you want to count by clicking 

and dragging across the appropriate cells click ok  

Notice that cells containing blanks text or error values are 

ignored )) )) 

COUNTBLANK حصائيةلاا الدالة 

  معين نطاق داخل بيانات على تشتمل لا التي الفارغة الخلايا عدد لحساب تستخدم

The COUNTBLANK Function counts the number of empty cells 

in a range of cells  

1-Select the cell where you want to place the result of 

calculation click on the formulas tab in the function library 

group click on statistical and then select COUNTBLANK the 

function Argument dialog box will appear  

2-Select the range of numbers you want to count by clicking 

and dragging across the appropriate cells  

3-When the correct cells are selected click the ok button  

COUNTA حصائيةلاا الدالة  

the counta function counts the number of cells that contain 

data in a list  

1- Select the cell where you want to place the result of 

calculation click on the formulas tab in the function library 

group click on statistical and then select COUNTA the function 

Argument dialog box will appear 

2-Highlight the range of numbers you want to count by clicking 

and dragging across the appropriate cells  

3-When the correct cells are selected click the ok button  



 

 

COUNTIFحصائيةلاا الدالة  

COUNTIF: Counts the number of cells within a range that meets 

the given condition  

1- select the cell where you want to place the result of 

calculation  

2-Click on the formulas tab in the function library group click on 

statistical and then COUNTIF  

 : حيث الدالة معاملات حدد

Range :منها الخلايا حساب تريد التي الخلايا نطاق إلى يشير 

Criteria :حسابها يتم التي الخلايا يحدد الذي المعيار إلى يشير  

Specify the Argument of the function: 

Range is the range of cells from which you want to count cells  

Criteria is the criteria that defines which cells will be counted 

Variance التباين  

Variance is an important measure of dispersion, which is 

calculated by averaging the squares of the individual deviations 

from the mean 

1- Select the cell where you want to place the result of 

calculation 

2-Click on the formulas tab in the function library group click on 

statistical and then select VAR the function Argument dialog 

box will appear  

3-enter the argument of the equation  

 



 

 

Standard Deviation المعياري نحرافلاا  

The positive square root of the variance is called the Standard 

Deviation  

1-select the cell where you want to place the result of 

calculation  

2-click on the formulas tab in the function library group click on 

statistical and then select STDEV the function Argument dialog 

box will appear  

3-enter the argument of the equation  

Median الوسيط  

the median is the value in the list of arguments that has as 

many values in the list that are greater or smaller if you sort the 

column the median value would be in the middle  

1-Select the cell where you want to place the result of 

calculation 

2-Click on the formulas tab in the function library group click on 

statistical and then select MEDIAN the function Argument 

dialog box will appear  

3-Highlight the range of numbers by clicking and dragging 

across the appropriate cells  

Logical Functions  الدوال المنطقية  

IF دالة  

  خاطئة ام صحيحة هي هل وتقرير معينة حالة لتفحص



 

 

the IF function checks a condition that must be either true or 

false if the condition is true the function returns on value; if the 

condition is false the function returns another value  

 

For example use the IF function We will use the IF function to 

type pass for students who get the grade 24 or more and to 

type Fail for students who got less than 24 

1-Select the cell where you want the result to be displayed Click 

the drop down arrow next to Logical and then select IF 

2-The function Arguments dialog box will appear  

 3-In the Logical test type the condition 

4-in the value if true box type the value excel will put in a cell if 

the test is true  

5-in the value if false box type the value Excel will put in a cell if 

the test is false 

6-click ok  

AND دالة 

AND: yields TRUE when all the argument are TRUE when one or 

more argument are false it yields FALSE  

OR دالة  

OR function yields TRUE when any of the argument is true 

when all argument are false this function yields FALSE 

Defining Names سماءلاا تخصيص  

you can name ranges of cells formulas and more A name makes 

it easy to reference a cell or range because you do not have to 



 

 

remember the exact cell address you simply need to remember 

the name  

1-Select the cell that you want to name  

2-click on the formulas tab in the defined names group click 

define names  

3-Enter the name you want into the name field of the dialog 

box names can be up to 255 and cannot look like cell 

references  

4-Click ok 

Deleting Range Names سماءلاا حذف 

1-Click on the formulas tab in the defined names group click 

name manager  

2-select the name you want to delete  

3-select delete and then select close  

 Using a Range Name in a formula  في المعادلات  الأسماءاستخدام  

1-Move to the cell to which you want to add a formula 

Construct the equation pausing whenever a name is required  

2-click on the formulas tab in the defined names group click use 

in formula and then click paste names the paste names dialog 

box will appear  

3-select the name you want and then click ok 

 

 

 



 

 

Subtotals الفرعية المجاميع 

Excel's subtotals lets you add your own subtotals to any sorted 

list of data. Subtotals will be created each time the data in a 

specified row differs from that in the row above  

1-Sort the data in an order that will produce the subtotals you 

desire; this example sorted by city 

2-click on the data tab in the outline group click subtotal . The 

subtotal dialog box will appear  

3-choose the column to be monitored for changes 

4-choose the function to be used (typically SUM for numeric 

subtotals or COUNT for counting things) 

5-choose the columns you want to subtotal 

6-choose the other appearance options you desire  

7-select the page break between groups check box to insert a 

page break between each group  

8-the subtotal and grand totals appear at the end of the data 

group by default  

9-To remove all subtotals select the data of interest and then 

click the Remove All button  

10-click ok 

Creating Charts المخططات إنشاء  

1-Select the cells that contain the data that you want to use for 

the chart  



 

 

2-Click on the Insert tab in the Charts group click the Chart type 

and then click a chart subtype that you want to use  

3-the chart will appear within the worksheet 

Creating a Combined Chart مختلط طمخط إنشاء 

1-Select the cells that contain the data that you want to use for 

the chart 

2-Click on the Insert tab in the charts group click the chart type 

and then click a chart subtype that you want to use  

3-the chart will appear within the worksheet  

4-right click the data series that you want to change and then 

select Change Series Chart Type  

5-select the required chart type .. Select ok  

Select Chart Element المخطط عناصر تحديد 

1-Click a chart the Chart Tools will appear  

2-Click on the Format tab in the Current Selection group click 

the arrow next to the Chart Elements box and then click the 

chart element that you want to select 

3-you can use the mouse to select a chart element  

Changing the Type of a Chart المخطط نوع تغيير 

1-Select the chart by clicking on it the Chart Tools will be 

displayed  

2-Click on the Design tab in the Type group click Change Chart 

Type  



 

 

3-The Change Chart Type dialog box will appear click the chart 

that you want to use 

Chart Title المخطط عنوان 

1-Click the chart to which you want to add a title the Chart 

Tools will appear  

2-Click on the Layout tab in the Labels group click Chart Title  

3-Click Centered Overlay Title or Above Chart  

4-in the Chart Title text box that appears in the chart type the 

text you want 

5-to edit a chart title click the chart and then click it again to 

place the cursor in the text area Type the new text 

6-to remove a chart title click the chart then click on the Layout 

tab in the Labels group click Chart Title and then click None 

Inserting an Image in a chart مخطط في صورة إدراج 

1-select the chart item that you want to add an image On the 

format tab in the Current Selection group click format selection  

2-select fill tab and then select Picture or texture fill 

3-click the Texture button arrow wand then select a texture  

4-to use a picture click the File button and browse your drives 

to locate a picture to insert and then click ok 

5-Choose whether to Stretch or Stack the image 

6-the default formatting click Automatic 

7-click ok 



 

 

Overlapping or Spacing Data Markers in Bar/Charts أعمدة تباعد 

  السلاسل

1-The Format Data Series dialog box will appear 

2-click the Series Options tab and then do one of the following:: 

3-to change the overlap of the data markers in each category 

drag the slider to the percentage of series overlap that you 

want the higher the value the greater the overlap within the 

category 

4-to change the spacing between categories of data markers 

drag the slider to the percentage of gap width that you want 

the higher the value the greater the distance between each 

category 

Adding Legend to a Chart المخطط إلى إيضاح وسيلة إضافة 

 سللالس تعيينها يتم التي لوانلاا يحدد الذي المربع هي Legend يضاحلاا وسيلة

  المخطط في الفئات أو البيانات

The legend identifies each data series on the chart with a 

different color to add remove or position a chart legend do the 

following : 

1-click the chart to activate it The Chart Tools will appear  

2-click on the Layout tab in the Labels group click Legend  

3-select the legend style you want  

Changing the Legend Fill Color يضاحلاا وسيلة ةخلفي لون تغيير 

1-Right click over the legend and then select format legend  

2-select the fill tab and then click on the Solid Fill button  

3-click on the down arrow next to color select a color 



 

 

4-Adjust the fill transparency  

Moving and Formatting Chart Data Labels  بيانات تسميات وتنسيق نقل 

 المخطط

1-Click in the Custom angle text box type a number to angle the 

text at 

2-to apply fill formatting to the data labels click fill and then 

select the option that you want 

3-select the data label by clicking it the cursor will change to 

include a four-headed arrow click and hold anywhere on the 

border and then drag the data label to the appropriate location 

Release the mouse button 

Changing the Scale of the Value Axis على الموجودة العرض وحدة تغيير 

 القيم محور

1-click on the Axis Options tab 

2-type a value in the Minimum box to specify the smallest data 

value you want to appear on the selected axis 

3-type a value in the Maximum box to specify the largest data 

value you want to appear on the selected axis 

4-type a value in the Major unit box to specify the interval of 

major tick marks and major gridlines 

5- type a value in the Minor unit box to specify the increment 

you want between the minor tick marks and the minor gridlines  

6-to flip the direction of bars or columns in a bar or column 

chart select the Values in reverse order check box  



 

 

7-select the Logarithmic scale check box to recalculate the 

values as shown in Minimum Maximum Minor and Major boxes 

as powers of 10 for the value axis 

8-type a value in Axis Value to specify the value at which you 

want the category X axis to across the value Y axis or select 

Maximum Axis Value to have the category X cross the value axis 

at the highest value  

Formatting the Value Axis القيم محور أرقام تنسيق 

1-Right click the value axis you want to change and then select 

Format Axis  

2-click the Number tab 

3-change the number formatting as needed 

Changing Angle of pie Chart Slices المخطط شرائح موضع استدارة 

 الدائري

1-Right click a data series in the pie or doughnut chart you want 

to change 

2-select Format Data Point the Format Data point dialog box 

will appear 

3-click the series Options tab 

4-in the Angle of first slice box drag the slider to specify the 

angle at which you want the first slice to appear 

Goal Seek ستهدافلاا 

Goal Seek is a method to find a specific value for a cell by 

adjusting the value of one other cell  



 

 

1-Click the data tab in the data tools group click What-If 

Analysis and then click Goal Seek  

2-in the set cell box specify the cell reference you want to use 

3-in to value box type the value you are looking for 

4-by changing cell this cell contains the value that can be 

changed during the calculation process 

5-click ok 

Scenarios السيناريوهات 

Scenarios are used when we need to know what the result will 

be when we change one or more variables in one or more 

situation (scenarios ) 

1-select the cells that you want to be able to change in the 

scenario 

2-click on the data tab in the data tools group click What-If 

Analysis and then click scenario Manager 

3-the add scenario dialog box will appear click the add button  

4-in the scenario name box type a name for the new scenario 

and then click ok 

5-in the Changing cells box enter the references for the cells 

that you want to change you can use commas between the 

variables  

6-click ok 

7-the scenario values dialog box will appear  



 

 

to add more scenario click add and then repeat steps three 

through seven 

8-to change scenarios view the scenario Manager dialog box 

and then select Edit or Delete if you want to delete a scenario  

9-when you have finished adding scenarios click ok you will 

again see the scenario Manager dialog box click close 

Creating Scenario Summary Reports السيناريو تلخيص تقرير إنشاء 

1-click on the data tab in the data tools group click what if 

analysis and then click scenario Manager the add scenario 

dialog box will appear click the summary 

2-choose scenario summary  

3-enter the cells that display the results and then 

4-click ok 

Presentation التقدمية العروض 

Microsoft PowerPoint is a presentation graphics program that 

helps you convey information to an audience 

 بيانية ورسوم نصوص على تحتوي إن يمكن التي الشرائح من مجموعة عن عبارة

 بواسطة عرضها يمكنك والتي مختلفة وإشكال  متحركة ورسوم وجداول وصور

  الحاسوب جهاز شاشة

 : بواسطة ألتقديمي العرض استعراض يمكن

 Screen الحاسوب شاشة

  Transparencies الشفافيات باستخدام

  overhead projector الشفافيات عرض جهاز باستخدام

  web page ويب كصفحة



 

 

 :وهي عتبارلابا التالية الخطوات اخذ من بد لا فعال تقديمي عرض إعداد وقبل

  planning التخطيط

  prepare التحضير

 practice التمرين

 presentation التقديم

planning Specify the knowledge and experience of your 

audience taking into account their needs age wants and goals     

prepare:  

--structure your presentation by centering it on a message with 

key points that you can back up with evidence 

--prepare an attention-getting opening make a starting 

statement using a question or relating to a relevant incident to 

elicit the audience's interest  

--you should be aware of the value of using pictures rather than 

too many texts charts and rows of figures at the same time do 

not use too many different backgrounds  

--you should know how big the audience and the room is? you 

may to use a projector a microphone and large font in a large 

room  

--it is well recommended to use the colors blue and green as 

they are very good for relaxation  

--prepare a memorable close that supports your purpose and 

creates a lasting impression 

Practice: your presentation in front of a colleague and ask for 

feedback on the content and style of your presentation 



 

 

presentation make  a positive first impression when speaking 

be yourself and relax speak in a heightened conversational tone 

slow down and emphasize important points and pause before 

and after key points to set them apart 

Bulleted Slides النقطي التعداد شرائح 

1-click on the home tab in the slides group click the arrow 

under new slide a gallery layout will appear  

2-select title and content  

3-replace click to add title with computer courses  

4-replace click to add text with the following lines of text: : 

windows 2007 

MS-Word 2007 

MS-Excel 2007  

MS-PowerPoint 2007  

MS-Access 2007 

5-the bulleted list will appear as you start typing in the box 

Changing the Layout of a slide الشريحة تخطيط تغيير 

1-on the slides pane select the slides you want to apply a layout 

to 

2-click on the home tab in the slides group click layout  

3-a gallery of slides layouts will appear  

4-click on the new layout you want to use the new layout will 

be applied to the current slide without affecting the slide's 

contents  



 

 

Themes السمات 

Microsoft PowerPoint provides Themes that you can apply to a 

presentation to give it a fully designed professional look  

1-click on the design tab in the Themes group click the theme 

that you want  

2-right-click the theme that you want and then do one of the 

following:  : 

--click apply to selected slides in order to apply it to the  

selected slide only 

--click apply to all slides in order to apply it to all slides 

3-you can change the colors the fonts 

character spacing حرفلاا تباعد 

1-Select the text to which you want to change  

2-click on the home tab in the font group click the character 

spacing drop down menu and select one of the options  

Removing Formatting النص من التنسيق إزالة 

1-Select the text containing the formatting you want to remove  

2-click on the home tab in the font group click clear formatting  

Text Alignment النص محاذاة 

1-select the text you want to align  

2-click on the home tab in the paragraph group click the 

alignment you want to use  

to adjust text position in a text box do the following: 



 

 

1-click the text inside the text box 

2-click on the home tab select one of the options 

Line Spacing سطرلاا تباعد 

Line Spacing determines the amount of vertical space between 

lines of text in paragraph by default lines are single-spaced 

1-select the paragraph which you want to change the spacing 

2-click on the home tab click the line spacing button in the 

paragraph group a list of options appears select the desired line 

spacing from the line spacing drop-down list 

paragraph spacing الفقرات تباعد  

paragraph spacing only affects the space before the first line or 

after the last line of the paragraph  

1-select the paragraph before or after which you want to 

change the spacing 

2-click on the home tab click the line spacing button in the 

paragraph group a list of options will appear select line spacing 

options 

3-the paragraph dialog box will appear click the up arrow next 

to the spacing before field to increase the space before the 

paragraph click the up arrow next to the spacing after field to 

increase the amount of space after the paragraph click ok 

creating a table جدول إنشاء 

1-insert a new slide with two content layout  

---two content use this slide layout if you wish to show text in 

addition to a graphic content type 



 

 

2-click insert table  

inserting text into a shape الشكل في نص إضافة 

1-right click the object and then select edit text a text box with 

a pointer will appear inside the object 

2-when you finish typing click anywhere on the slide 

SmartArt إدراج 

1-Click on the insert tab in the illustrations group click SmartArt 

2-use the text pane to type your text 

Align Drawn Objects الرسومية الكائنات محاذاة 

1-select the object s you want to align  

2-under drawing tools click on the format tab in the Arrange 

group select one of the options 

Organization Chart هيكلي مخطط وتعديل إنشاء 

1-create a new blank slide click on the insert tab in the 

illustrations group click SmartArt  

2-the choose a SmartArt Graphic  

3-click Hierarchy click an organization chart layout and then 

click ok 

4-To enter your text click text in the slide pane and then type 

your text or use the text pane to type your text  

5-to change the direction of the organization chart in the 

design tab in the create graphic group click right to left 

to add a shape do the following: 



 

 

--select the shape under which or next to which you want to 

add the new shape under or next to under SmartArt tools click 

on the design tab in the create graphic group click the arrow on 

the add shape 

Slide Master الرئيسية الشريحة 

 الشرائح في تلقائي بشكل تظهر التي العناصر كل على تحتوي شريحة عن عبارة

 ضفاءلإ له ساسيةلاا الخصائص وتعريف ألتقديمي العرض لبناء يستخدم والذي

 شرائح كامل على التغير يتم فيها خاصية إي بتغير قمت اذا الشرائح على ثابت شكل

 ألتقديمي العرض

Master is a slide that contains everything that appears by 

default on all the slides it gives your presentation a consistent 

professional look A slide master determines the basic design for 

every slide in your presentation any changes you make to the 

slide master will be reflected on all sides in your presentation  

 

1-click on the home tab in the presentations views group select 

slide master the slide master window will appear  

2-to the left in the slides/outline pane you will see thumbnail 

images of the slide master and all the different slide layouts 

that are contained within the slide master 

3-you can make changes to the slide master just as you would 

change any slide make any changes you want to the font size 

color or alignment also you can add a picture to the master 

slide and make a change in the bulleted list as you have learned 

before...remember that the text on the master is only for 

styling actual slide text such as titles and lists should be typed 

on the slide in the Normal View 



 

 

4-use the slide master tab to make one or many changes to the 

slide master 

5-click close master view on the slide master tab the changes 

you made are applied to all slide  

6-when you change the slide master the changes you have 

made to individual slides are preserved 

slide footer الشرائح تذييل  

To add a data slide number or footer to your PowerPoint slides 

do the following: 

1-on the home tab in the text group select Header and footer 

the header and footer dialog box will appear  

2-to add an automatically updating date and time click update 

automatically and select a date and time format 

3-to add a fixed date and time click fixed and type a date and 

time  

4-click slide number to add a number  

5-to add a footer text click footer and type your text  

6-select the Do not show on title slide check box if you do not 

want the information to appear in the first slide 

7-click apply to add the information to the selected slides click 

apply to all to add the information to every slide in the 

presentation 

Animation Effects الحركة تأثيرات 

1-select the object to which you want to add an animation  



 

 

2-on the Animations tab in the Animation group click the arrow 

next to Animate 

3-PowerPoint gives you a preview of what the animation looks 

like by animating the current slide if you want to see the 

preview again just click the animation scheme again click an 

animation scheme in the list to remove the animation effects 

click no animation 

Custom Animation المخصصة الحركة 

1-select the object you want click on the Animation tab in the 

animation group click custom animation the custom animation 

task pane will appear  

2-select the object you want and then click add effect  

3-select one of the animation effect the animated items are 

noted on the slide by a non-printing numbered tag that 

correlates to the effects in the list this tag does not show up in 

the slide show view  

4-to specify the animation time select: 

--on click start the animation on the mouse click  

--with previous start the animation at the same time as the 

previous animation could be another animation on this slide or 

the slide transition of this slide 

--after previous start the animation when the previous 

animation or transition has finished 

5-choose an animation speed from the drop down list speeds 

vary from slow to very fast 

6-click play to preview the animation for a slide again  



 

 

7-to change an effect select the animation item in the task 

pane and then click change 

8-to remove an effect select the animation item by clicking its 

number and then click remove 

Copying Slides within a presentation العرض ضمن الشرائح نسخ 

 ألتقديمي

1-switch to slide sorter view click on the slide you want to copy  

2-press the Ctrl key drag the mouse pointer to the new location 

within the slide and then release the mouse button  

Copying or Moving Slides between Presentations نقل أو نسخ 

 آخر تقديمي عرض إلى الشرائح

**To Copy a slide press Ctrl+C 

**To move a slide press Ctrl+X  

2-open the file in which the selected text will be pasted or use 

the window menu or the taskbar to move to the new 

application 

3-within the new application position the cursor to the location 

where you want the slide and then press Ctrl+V 

Hiding and Showing Slides الشرائح وإظهار إخفاء 

1-On the slides tab click on the slide you want to hide 

2-Right click the slide that you  want to hide and then click Hide 

Slide 

3-the hidden slide icon appears with the slide number inside it 

next to the slide you have hidden  

Slides Setup الشرائح إعداد 



 

 

1-click on the design tab in the page setup group click page 

setup 

2-in the slides sized for list select the appropriate output 

format for slide presentation such as overhead handout 35 mm 

slides on screen show 

3-under number slides from enter the number you want the 

slides to start with  

4-to set the page orientation for the slides click Landscape 

(wider than it is tall) or portrait (taller than it is wide) 

Handouts النشرات 

are printed copies of your presentation slides with handouts 

you have the option of printing two three or six slides on a 

handout page you can leave space for your audience to take 

notes on your presentation 

1-click on the Office button point to print and then click print . 

the print dialog box will appear select Handout from print what 

box  

2-specify the number of slides per page if three is chosen the 

slides will display on the left or the page with space for notes 

on the right 

3-click Horizontal or Vertical to specify the order you want the 

slides printed 

Adding slides from another presentation عرض من شرائح إضافة 

 أخر تقديمي

1-Open the presentation that you want to add a slide to 

2-Click where you want to add a slide 



 

 

3-Click on the home tab in the slides group click the arrow next 

to New Slide 

4-Click Reuse slides the reuse slides task pane will appear 

5-click Browse and then click Browse file  

6-the Browse dialog box will appear click the presentation file 

that contains the slide that you want and that click Open 

7-thumbnails of the slides from the presentation that you 

selected will appear on the Reuse slides task pane  

--to add a single slide click the slide 

--to add all of the slides right click any slide and then click insert 

all slides  

8-if you want the slide that you are adding to the destination 

presentation to maintain the formatting of the original 

presentation select the keep source formatting check box 

before you add the slide to the destination presentation 

 

Action Buttons جراءاتلاا أزرار إدراج 

Action Buttons contain shapes such as right and left arrows use 

them when  you want to include commonly understood 

symbols for going to next previous first and last slides you can 

use these buttons for a self-running presentation at a kiosk or 

for a presentation that you plan to publish on your company 

intranet or the Internet PowerPoint also has action button for 

playing movies or sounds 

1-to create an action button that links to a slide 



 

 

2-On the insert tab in the illustrations group click shapes 

3-under action buttons click the button that you want to add 

4-click a location on the slide and then drag to draw the shape 

for the button the action settings dialog box will appear 

5-Click the mouse click tab and then do one of the following: 

--to use the shape without a corresponding action click none  

--to create a hyperlink click hyperlink to and then select the 

destination for example the next slide the previous slide the 

last slide or another PowerPoint presentation or a Microsoft 

Word document or table a Microsoft Excel spreadsheet or 

address on the Internet that you want the hyperlink action to 

go to 

To move to another presentation click the drop list next 

Hyperlink to select Other PowerPoint presentation and then 

select the file you want the Hyperlink to slide dialog box will 

appear click the slide you want the hyperlink to jump to and 

then click ok  

 

To create an action button that links to another Word or Excel 

file click the drop down list and then select Other File the 

hyperlink to Other file dialog box will appear select the file you 

want and then click ok 

 

* To create an action button that links to a Web page click the 

hyperlink to and then select URL .enter the URL you want the 

hyperlink to jump to click ok  



 

 

 

*To run a program click run program click Browse and then 

locate the program that you want to run 

 

*To play a sound select the play sound check box and then 

select the sound that you want to play… click ok 

 

It is possible to change the destination of an action button after 

creating it 

1-Right click on the action button  

2-click Edit Hyperlink  

3-the Action settings dialog box will appear change the link 

 

Custom Shows العروض المخصصة 

Custom Shows allow different parts of one presentation to be 

shown as different shows to different level of audiences 

without the need for creating multiple versions of the same 

presentation for example an audience of sale people could see 

a presentation without seeing those slide relating to finance 

staff that could be given the same presentation but without the 

sales slides A custom show can be set up so the certain slides 

can be missed out when necessary to create a custom show do 

the following: 

 



 

 

1-Open the presentation for which you want to create a custom 

show 

2-under slide show in the start slide show group click the arrow 

next to custom slide show click custom show  

3-the custom shows dialog box will appear 

4-click new  

5-type a name in the slide show name box 

6-under slides in presentation select the slides you want to 

include in the custom show and then click add to select 

multiple slides hold down the Ctrl key as you click the slides 

click ok 

7-Repeat the steps above so as to create more custom shows 

8-to preview a custom shown on the custom shows dialog box 

select the name of the show click ok 

9-to remove a custom show click the custom show that you 

want to remove and then click remove 

 

Adding or Removing Slides in a Custom Show إزالتها أوشرائح  إضافة 

 في عرض مخصص

1-under slide show in the start slide show group click the arrow 

next to custom show 

2-the custom shows dialog box will appear select the name of 

the custom show you want to change and then click Edit  

3-add or remove the slides you want and then click ok 

to run a custom show do the following 



 

 

1-on slide show tab in the set up group click set up slide show 

2-the set up show dialog box will appear 

3-under slide slides click custom show and then click the name 

of the custom show that you want  

4-click ok  

5-on view tab in the presentation views group click slide show  

 

Creating an Action from a Symbol من رمز إجراء إنشاء 

if you want to apply an interaction to an image that will branch 

on a mouse clicking during a slide show to a customized show 

and return to the original presentation when the customized 

show is finished do the following 

1-draw a shape 

2-right click the image then select Hyperlink to display the 

insert Hyperlink dialog box  

3-select places in this Document 

4-select the custom show you want to jump to 

5-click on the show and return check box  

6-click ok 

 

Timing طرق تعيين توقيت عرض الشرائح 

you can either use Manual timing to advance the slides by 

clicking the mouse button when you are ready to move on or 

use Automatic timing to advance the slides automatically after 



 

 

a preset period of time the manual timing gives you more 

control but the automatic timing helps you stay within a 

specified time frame 

1-in the normal or slide sorter view select the slide or slides you 

want to set the timing for 

2-click on the insert tab under Advance do the following 

*to advance the slide manually click on mouse click check box 

*click automatically after check box and then enter the number 

of seconds to determine the time during which you want the 

slide to appear on the screen 

*to apply the timing to all the slides click apply to all 

*select both the on mouse click and the automatically after 

check boxes if you want the next slide to appear either when 

you click the mouse or automatically 

 

Rehearse Timing  وتوقيته ألتقديميالعرض  إلقاءالتدرب على 

you can practice what you will talk about and set the length of 

time during which the slide will appear before automatically 

switching to the next slide 

1-switch to slide sorter view click on the slide show tab 

2-practice what you will talk about click to restart recording or 

click to move to the next slide  

3-repeat the procedures in order to establish the timing for the 

entire set of slides in your presentation a message box displays 

the total time for the presentation click yes to keep the 



 

 

recorded slide timing or click no to discard the recorded slide 

timing 

4-the time required to view each slide will appear next to the 

slide in slide sorter view  

5-if you know the time that you want for the slide enter it 

directly in the Rehearsal toolbar 

6-to cancel the timing on Animations tab under Advanced clear 

the automatically after check box click apply all to cancel the 

timing for all slides 

7-if you do not want the slides in your presentation to advance 

automatically by using the slide timings that you recorded on 

the slide show tab in the set up group clear the use Rehearsed 

timings check box to turn the slide timings on again select the 

use Rehearsed timings check box 

 

 

 


